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Forty-five years ago, IME began with a simple goal — to 
help local industries work smarter by supporting their 
tools and machines. Over the decades, we have embraced 
change, challenged norms, and ventured into new 
frontiers of technology. Today, as we celebrate 45 years of 
innovation and excellence, we continue to pursue a future 
that is fit for the digital age, empowering industries to 
innovate with purpose, agility, and heart.

This year’s theme, “Let’s Amaze Together” reflects our 
ongoing commitment to pushing boundaries through 
Fit-for-the-Future Digital Transformation. We explored the 
potential of AI, not as a replacement for human ingenuity, 
but as a tool to enhance efficiency, precision, and 
productivity across our operations. It is this mindset of 
leveraging technology while keeping human creativity at 
the center that continues to guide our journey forward.

Over the past year, we strengthened our relationships with 
key government agencies, building on successful 
collaborations with the Northern Corridor Economic 
Region (NCER), MIMOS Digital Transformation and 
Technology Management (DDTM), Standards and 
Industrial Research Institute of Malaysia (SIRIM), and the 
Federation of Malaysian Manufacturers (FMM). Our 
TUSAS Apprenticeship Programme continued to nurture 
the next generation of talent, while our engagements with 
universities such as Tunku Abdul Rahman University of 
Management and Technology (TARUC) and Universiti 
Sains Malaysia (USM) during the LIMA visit reinforced our 
commitment to education and industry-academic 
collaboration. These initiatives help prepare future-ready 
professionals and strengthen the wider ecosystem of 
innovation.

Across our operations, exciting developments in 
technology adoption, process optimisation, and service 
excellence have also continued to unfold. From advancing 
digital tools that enable greater efficiency and precision, 
to introducing new approaches that enhance 
collaboration and customer experience, these efforts 
reflect our drive to remain at the forefront of 
transformation. Each step we take is guided by a 
commitment to deliver practical solutions that create 
lasting value — ensuring industries are not only equipped 
to meet today’s challenges, but are also ready to seize the 
opportunities of tomorrow.

IME Innovation Day is more than a showcase of 
technology — it is a celebration of resilience, 
collaboration, and forward-thinking that spans 45 years. 
Our journey is far from over. Together with our customers, 
partners, and communities, we remain committed to 
exploring new horizons, inspiring innovation, and shaping 
a future that is truly fit for the next decade and beyond.

Teoh Tuan Ka
Founder and Chairman, IME Group of Companies

T.k. Teoh

Thank you for being part of our journey.

Continuing  the Journey
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Understanding Dell Pro Max  
Users and Use Cases

Dell Technologies is simplifying our product portfolio to make 

and solution priorities. Use this guide to:

1 the Dell Pro Max portfolio.

2 Identify the three Dell Pro Max user types that are common 

3  
a guide to the appropriate product.

A Tailored 
Product Lineup
Our product portfolio 
ranges from consumer  
PCs and gaming systems 
to Dell Pro for professional-
grade productivity and Dell 
Pro Max for performance 
and scalability.

Why Pro Max?
Dell Pro Max products are engineered to serve 

where performance, scalability and reliability are critical 
to productivity and success.

Key Value Propositions:

Designed for professionals with data-

Customizable performance to match 
unique user needs

Scalable solutions across diverse 
professional applications

Pro Max = Performance

data to 3D CAD, Dell Pro Max users need to multitask, 
interact rapidly and handle complex applications.

Characteristics:

Supports seamless multitasking across 
complex applications 

Enables rapid data interaction and quick 
delivery of results

Engineered to handle large datasets 
effortlessly with the power of GPU 



The true strength of Dell Pro Max lies in its adaptability.
An architect designing a 50-story high-rise and another
working on a single-family home will have different

Characteristics:

project complexities

individual professional requirements with up 
to Quad NVIDIA Professional GPUs

Support for multiple monitor setups and  
high-resolution displays

Three common user types across all industries who require performance PCs

Power users and collaborators

Business stakeholders needing 
performance to interact with critical, 
complex or large datasets.  

• Managers  
• Leaders 
• Stakeholders
• AI end users

Recommended products:  
Dell Pro Max, Dell Pro Max Premium,  
Dell Pro Max Slim/Micro

Creators 

Professionals primarily creating digital 
design, data or content.   

• Engineers  
• Designers  
• Artists  
• Editors
• Scientists

Recommended products:  
Dell Pro Max, Dell Pro Max Premium,  
Dell Pro Max Plus, Dell Pro Max Slim/Micro,  
Dell Pro Max Tower T2, Dell Precision  
5860 Tower

Specialists 

Experts using advanced computing 
solutions that scale with core count.  

• 
• Visualization specialist
• Reality capture engineer
• Energy researchers
• AI builders and developers

Recommended products: 
Dell Pro Max Plus, Dell Pro Max Tower T2, 
Dell Precision 5860 Tower, Dell Precision 
7960 Tower, Dell Precision 7875 Tower

Product View with Prioritized Use Cases/Features 

Copyright © 2025 Dell Inc. or its subsidiaries. All Rights Reserved. Dell Technologies, Dell and other trademarks are trademarks of Dell Inc. or its subsidiaries. Other trademarks may be trademarks of their respective owners. This infosheet is for 
informational purposes only. Dell believes the information in this infosheet is accurate as of its publication date, February 2025. The information is subject to change without notice. Dell makes no warranties — express or implied — in this infosheet.



As the inaugural certification programme organised by DDTM (Digital Design & Technology Malaysia), this 
milestone was powered by MIMOS and supported by IME Technology. IME trained participants across the 
Fundamental, Intermediate, and Advanced Certified SOLIDWORKS Professional (CSWP) levels, ensuring they 
not only passed certification exams but also developed practical skills for real-world product design and 
engineering workflows.

Participants didn’t just walk away with certificates — they gained the ability to design smarter, streamline 
development, and bring greater innovation to their organisations.

A First for DDTM, Powered by MIMOS, Delivered by IME

The Certified SOLIDWORKS Professional (CSWP) 
credential is globally recognised as a mark of excellence in 
3D CAD design. Certified professionals demonstrate the 
ability to create complex parts and assemblies, solve 
engineering challenges, and apply best practices in design 
and manufacturing.

For SMEs, having CSWP-certified staff means faster 
product development, fewer design errors, and a stronger 
competitive edge in innovation-driven markets. This 
makes the DDTM programme particularly valuable for 
companies looking to strengthen their in-house design 
capabilities and scale products from concept to 
production.

What is SOLIDWORKS Certification and Why It Matters

DDTM SOLIDWORKS Certification Programme 2025:
A Milestone for Malaysian SMEs

INNOVATION HIGHLIGHTS



This September, the first DDTM SOLIDWORKS Certification Programme concluded successfully, drawing over 
150 registrations from across the nation. From this pool, 80 participants embarked on the journey at 
Fundamental level, with 47 advancing to Intermediate, and ultimately 31 progressing to the Advanced 
stage and successfully earning CSWP certification — a highly selective achievement that positions these 
professionals as trailblasers in digital design.

Training sessions were conducted across Malaysia’s key 
innovation hubs — Kuala Lumpur, Penang, Kulim, Johor, 
and Kuantan — ensuring the programme’s influence 
reached SMEs nationwide.

Building on the previous year’s initiatives, which 
provided over 100 SOLIDWORKS licences and 
foundational training to SMEs, this programme continues 
to strengthen practical skills and in-house design 
capabilities, helping companies scale products from 
concept to production.

Empowering SMEs Across Malaysia 

The overwhelming response to this year’s programme makes one thing clear: this is just the beginning. With 
SMEs and professionals across Malaysia eager for upskilling, future editions of the DDTM SOLIDWORKS 
Certification Programme have the potential to reach even more participants.

With an increasing number of SOLIDWORKS-certified professionals — with IME as the supporting partner — 
Malaysia is taking meaningful steps toward building a workforce capable of innovating, competing, and 
leading in the Industry 4.0 era.

Looking Ahead: Building Malaysia’s Digital Design Talent

This programme was proposed to enable 
SMEs to create, design, and develop their 
own products, and eventually scale up to 
mass production.

Mr. Sheikh M Shahrizal Mohd Rafique
MIMOS BERHAD

Beyond Certification: IME’s Commitment to Continuous Upskilling
IME’s role in Malaysia’s talent development extends far 
beyond certifications. With decades of experience in 
engineering solutions and training, IME continues to 
support manufacturers, SMEs, and professionals 
through:

By connecting certification, past initiatives, and practical 
upskilling, IME positions Malaysia’s workforce to design, 
innovate, and scale with confidence in the era of 
Industry 4.0.

Advanced Training Programmes:
from CAD, CAM, and CAE to additive manufacturing and 
smart automation.

Industry Collaboration:
partnering with government agencies, universities, and 
companies to accelerate innovation.

Technology Deployment:
helping companies adopt and integrate SOLIDWORKS, 
simulation, and digital manufacturing platforms.

End-to-End Support:
consultancy, hands-on workshops, and ongoing 
technical guidance to ensure sustainable growth.

INNOVATION HIGHLIGHTS



All enhancements apply to SOLIDWORKS Design solutions unless stated otherwise.

WHAT’S NEW IN SOLIDWORKS  2026 - DESIGN

AI-POWERED DESIGN AND DETAILING

Speed up drawing creation with AI-powered views and hole callouts, 
as well as automated dimensioning, detailing, sheet format selection, 
and scaling.

Use AI to automatically recognize and assemble components that 
look like fasteners — such as nuts, bolts, washers — saving time, 
reducing manual effort, and improving assembly accuracy.

1
Accelerate assembly 
design and drawing 
creation through the 
power of AI.

Work smarter with 
large assemblies using 
more streamlined, 
production-ready 
workflows.

ENHANCED LARGE ASSEMBLIES FEATURES
Speed up the opening of large assemblies by selectively filtering 
specific portions of your design from the 3DEXPERIENCE® platform 
using component relationship visualization and advanced filters to 
find relevant parts.

2

Skip rebuilds when only cosmetic changes are made.

Disable Auto-Resolve for lightweight components.

Stay productive even 
during internet 
disruptions, and help 
new users get up to 
speed faster.

IMPROVE USER EXPERIENCE
Maintain productivity during connectivity issues with automatic 
offline mode for uninterrupted access.

Simplify workflows with a UI that highlights commonly used 
commands, helping new users focus on design.

Find commands more easily in Command Search using an expanded, 
customizable set of keywords.

3

Create parts faster 
with improvements to 
part features and 
sketching.

STREAMLINED PART DESIGN
Streamline Physical Product creation by easily adding key attributes 
at the start of the design process.

Define a custom start point for a sheet metal base flange and break 
internal corners on folded geometry.

Quickly create square sketch geometry in one click.

4

Stay connected and 
up-to-date more easily 
with both your data 
and team.

MORE EFFICIENT COLLABORATION AND
DATA MANAGEMENT

Track maturity changes and view drawing history with Evaluated 
Attributes, eliminating manual updates.

Share designs using 3DDrive and 3DSwym, and access the User 
Forum directly from within SOLIDWORKS.

Update a selected file to the latest version on the 3DEXPERIENCE 
platform, ensuring accuracy.

5
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IMPROVED DRAWING DETAILING AND MBD

Insert a Family Table into a drawing to display cofiguration details and 
custom properties.

Use magnetic lines to support attaching and aligning Notes, Weld 
Symbols, and other annotations - beyond just balloons.
expanded

Propagate DimXpert™ dimensions to Library Features,
and selectively hide and show annotations.

6
Streamline drawings 
with expanded 
detailing options and 
improved MBD 
annotation control.

Streamline routing 
design and reduce 
manual effort with 
expanded capabilities.

MORE FLEXIBILITY FOR ELECTRICAL,
PIPE, AND TUBE ROUTING*

Combine routing BOMs from multiple subassemblies to show a clear 
total for each item used across the design.

Route pipe, tube, and electrical paths using clips, mounts, or hangers 
placed in parts or assemblies, improving design flexibility.

Provide clear visual indicators to guide placement of splices within 
harness and wire bundles, enhancing accuracy.

7

Streamline the ECAD
/MCAD collaboration 
process for a more 
complete PCB design 
workflow.

STREAMLINED ECAD/MCAD
COLLABORATION AND DESIGN

Store and track parent and child data — including keep-in, keep-out, 
PTH, and NPTH details — improving traceability.

Using CircuitWorks™, review and undo MCAD changes before final 
ECAD updates by overwriting the previous push in IDX 3.0.

8

Create more
compelling, immersive 
content to inspire your 
customers.

MORE EFFICIENT RENDERING**
Balance geometry quality and performance with tessellation control 
and faster import speeds.

Reduce noise in fewer passes by enabling the Denoiser in CPU mode.

Streamline the creation of renderings from imported models with 
support for PBR materials in USDZ and glTF file formats.

9

Save time and reduce 
errors when 
collaborating outside 
your team.

MORE PRODUCTIVE IMPORT/EXPORT
Simplify complex multibody parts faster by using advanced selection 
tools to efficiently isolate and manage bodies based on similarity or 
size.

Share assemblies saved on the 3DEXPERIENCE platform using the 
Export as Package option in the Share dialog box.

Streamline exports by choosing whether to include drawings in your 
package, for greater control.

10
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These enhancements apply to all DraftSight Augmented and DraftSight solutions unless stated otherwise.

WHAT’S NEW IN DRAFTSIGHT 2026

BIM MODULE*

Enhance your 2D drafting by integrating Building Information 
Modeling (BIM).

Import RVT and IFC files to generate precise plans, sections, 
elevations, and schedules, streamlining collaboration and
communication.

1
Bridge collaboration 
between 3D and 2D 
teams.

Standardise project 
documentation and 
simplify publishing.

SHEET SET MANAGER ON THE PLATFORM**
Streamline project organisation by managing drawing sheets with the 
Sheet Set Manager.

Create and group sheets, apply templates, use custom properties, and 
manage sheet model views to standardise and efficiently publish 
documentation across your project.

2

Save time and ensure 
printing consistency
across teams.

BATCH PRINT FILES IN
COLLABORATIVE SPACE**

Accelerate your printing workflow by processing multiple drawings at 
once directly within your Collaborative Space, ensuring consistent 
output and use of the latest version.

3

Improve productivity 
and workflow for 
multi-monitor users.

FLOAT DOCUMENT WINDOWS*

Boost productivity on multi-monitor setups by detaching drawing 
tabs into separate, movable windows. This feature is ideal for 
side-by-side comparison and editing of multiple drawings in a single 
session.

4

Access projects, recent 
files, and resources 
faster.

CENTRALISED START HUB*

Gain quick access to workspace settings, projects, recent files, and 
learning resources with the new centralised launchpad for
streamlining your workflows from the moment you open the
application.

5
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IMPROVED RIBBON TABS CONTENT

Work more efficiently with a cleaner, better-organised ribbon 
interface that enhances usability through improved command access 
and familiar, customisable workspace layouts.

6 Streamline workflows 
with quicker and more 
intuitive command 
access.

Reduce manual work 
and errors in data 
extraction.

DATAEXTRACTION COMMAND
IMPROVEMENTS

Extract data more efficiently thanks to new features, including CSV 
headers and built-in formula columns that reduce manual work and 
streamline integration with other applications.

7

Automate dynamic text 
and calculations within 
drawings.

FIELD COMMAND: ADD DIESEL
EXPRESSION SUPPORT

Achieve greater flexibility and automation by using custom fields with 
Diesel expressions, which allows for calculations
and conditional formatting directly within your drawings’ text.

8

Improve multitasking 
and simultaneous 
model navigation.

RESIZABLE VIEW TILES IN MODEL SPACE*
Improve multitasking within your CAD workflow with adjustable view 
tiles that let you efficiently view and navigate multiple model areas 
simultaneously through intuitive resizing and alignment.

9

Simplify cloud data 
management and 
team collaboration.

MORE PRODUCTIVE IMPORT/EXPORT
Enhance collaboration and streamline workflows by directly attaching 
DWG files from the cloud-based 3DEXPERIENCE platform as external 
references, improving overall data management.

10
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WHAT’S NEW IN SOLIDWORKS  2026 - SIMULATION

FORCE OPTIONS FOR BEAMS

Choose between Per Item and Total definitions when
applying force to beam elements.

Gain more precise control in structural simulations.

1
Improve modeling 
efficiency with greater 
flexibility inload 
definition.

Improve design
accuracy and
streamline analysis of 
pinned joints in 
vibration environments.

PIN CONNECTOR FORCE RESULTS IN
RANDOM VIBRATION

Extract detailed Pin Connector forces in random
vibration simulations.

Obtain full-force breakdown, including shear force, axial
force, bending moment, and torque.

2

Choose the angle
measurement unit
to align with your 
engineering 
standards and project 
requirements.

ANGULAR DISPLACEMENT PLOT OPTIONS

Plot angular rotation results in either degrees or radians,
offering greater flexibility in how displacement data is
displayed and interpreted.

3

Boost simulation 
accuracy
and speed by resolving
setup issues with 
clearer, faster
diagnostics.

VALIDITY CHECK IMPROVEMENTS

Improve simulation reliability with clearer alerts for
missing materials, invalid mesh controls, and incomplete
fixture definitions.

Accelerate issue resolution with one-click deselection
for reports, quicker access to stress diagnostics, and
streamlined validation messages.

4

Streamline setup and
enhance modeling 
accuracy for complex 
shell structures.

SHELL IMPROVEMENTS

Save time on setup by setting global defaults for thick or
thin shell definitions.

Specify distributed remote loads/mass on shell edges.

5
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REMOTE MASS IN RESPONSE SPECTRUM

Apply remote masses as part of response spectrum analysis.

Capture the effect of components not included in the mesh by
applying their mass externally to the structure.

6
Optimise simulation 
setup by using remote 
masses in place of 
physical components.

Identify incomplete 
material injection 
zones alongside
short-shot predictions.

POST-PROCESSING ENHANCEMENTS

View the new Unfilled Volume plot added in Fill
simulation results alongside short-shot predictions.

Easily identify areas that remain unfilled due to
incomplete material injection.

7

Improve simulation 
realism by defining Air 
Vent boundary
conditions directly
on model edges.

EDGE-BASED AIR VENT DEFINITION

Define Air Vent boundary conditions directly on model
edges for realistic venting analysis.

Apply vents to both Cavity and Cold Runner System domains
to better reflect mold behavior.

8

Capture heat transfer 
paths more precisely, 
especially in tightly 
packed or glued
components.

FILL THIN SLOT FEATURE

Fill thin gaps automatically with specified materials for
more realistic thermal modeling.

Simulate real-world assemblies accurately by applying
userdefined thickness thresholds.

9

Identify overheating
components or 
imbalanced heat 
sources more 
efficiently.

COMPONENT EXPLORER: NEW COLUMNS

View a summary of all component temperatures and
surface sources directly within the Component Explorer.

Enable faster thermal assessment at a glance.

10
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SAVING SOLIDWORKS DOCUMENTS AS A PREVIOUS 
RELEASE VERSION

You can save your parts, assemblies, and drawings to up to two previous year’s 
version of SOLIDWORKS.

TIPTIP
11

DOCUMENT GROUPS

You can save all open files in SOLIDWORKS as a single document group. 
This lets you open all the files saved in that group at once.

TIPTIP
22

GRAPHICS TRIANGLE AND FACE COUNT FROM 
PERFORMANCE EVALUATION TOOL

Helps you determine the model complexity and predict the impact on  
performance, directly from the Performance Evaluation tool.

TIPTIP
33

CYLINDRICAL BOUNDING BOXES

You can create cylindrical bounding boxes that are useful for bodies with 
cylindrical geometry such as rotational, circular, or turned parts.

TIPTIP
44

AUTO-REPAIR SKETCH DIMENSIONS OR RELATIONS

Automatically find and resolve dangling dimensions or relations with just a single 
click.

TIPTIP
55

DRAFTSIGHTSOLIDWORKSPRACTICAL
INSIGHTS

PRACTICAL INSIGHTS



KEEP TRIMMED ENTITIES AS CONSTRUCTION 
GEOMETRY

You can convert trimmed entities into construction geometry or 
ignore construction geometry when trimming. This improves the 
handling of construction geometry for 2D and 3D sketches.

TIPTIP
66

SHEET METAL BEND NOTCHES

Use the new bend notch feature to create visible marks across bends. In 
manufacturing, bend notches help manufacturers determine where to 
put the press brake.

TIPTIP
77

TASK SCHEDULER WITHIN 3DEXPERIENCE 
SOLIDWORKS

Initiate Task Scheduler from within SOLIDWORKS User Interface to 
run scheduled tasks in the background, even when the workstation is 
unattended.

TIPTIP
88

AUTOMATIC GENERATIONS OF DRAWINGS

Leverage the power of AI to automatically generate drawings form 
parts and assemblies using 3DEXPERIENCE SOLIDWORKS.

TIPTIP
1010

AI-BASED AUTOMATIC FASTENER 
RECOGNITION AND ASSEMBLY

Auto-detects non-toolbox fasteners (e.g. custom or outsourced bolts, 
nuts, washers) and automatically assemble them into position upon 
insertion — no manual mates needed.

TIPTIP
99

PRACTICAL INSIGHTS



AUTO-FILS TABLE CELLS

Auto-fill is useful when you want the data in a logical or repetitive order in 
the adjacent cells of a table. The data includes dates, sequential numbers, 
days of the week, months etc. To access tables: 
• On the ribbon, click Annotate > Table > Insert. 
• On the menu, click Draw > Table. 
• Enter TABLE in the command window.

TIPTIP
11

DYNAMIC SEARCH IN AN OPTIONS 
DIALOG BOX

The search functionality in the Options dialog box is more intuitive and user 
friendly, ensuring that you find options quickly. In the Search box of the 
Options dialog box, start to enter a term or system variable name to see a list 
of options containing the string that you entered. Relevant options appear 
in a list. You can click an option to go directly to the specified option. To use 
the dynamic search in the Options dialog box:
• On the ribbon, click Manage > Customisation > Options. 
• On the menu, click Tools > Options. 
• Enter OPTIONS in the command window.

TIPTIP
22

DIMENSIONS STYLES DIALOG BOX

The Dimension Styles dialog box is simplified for editing Dimension Styles. 
When you edit Dimension Styles, the user interface more closely resembles the 
other 2D CAD interface. This ensures a smoother transition for users migrating 
from 2D CAD to DraftSight. To access the Dimension Styles dialog box:
• On the ribbon, click Annotate > Dimension > Dimension Style. 
• On the menu, click Format > Dimension Style. 
• Enter DIMSTYLE / DIMENSIONSTYLE in the command window.

TIPTIP
33

EDITING CLIPPED EXTERNAL
REFERENCES AND BLOCKS

When you clip a block or an externally referenced (xref) drawing, you can 
resize or edit their boundaries with grips. In earlier releases, you had to 
recreate the clip each time you resized or edited the boundaries. This makes 
it easier to isolate a specific entity or area from the block or xref drawing to 
display in the graphics area. To edit clipped external references and blocks:
• On the ribbon, click Insert > Reference > Clip > Reference. 
• On the menu, click Modify > Clip > Reference.

TIPTIP
44

DRAFTSIGHTDRAFTSIGHTPRACTICAL
INSIGHTS

PRACTICAL INSIGHTS



MANAGING SPACING BETWEEN DIMENSIONS

You can use the DIMSPACE command to manage the spacing between 
dimensions in DWG files. This ensures precision, clarity, and design consis-
tency in drawings. With the DIMSPACE command, you have greater 
precision and can spend less time on manual adjustments. The DIMSPACE 
command is similar to 2D CAD functionality for drawing dimensions, so it is 
easy to learn if you are familiar with 2D CAD.

TIPTIP
55Before DIMSPACE

After DIMSPACE

MENU BAR VISIBILITY

You can use the ribbon and menu bar simultaneously in the user interface. The 
Customise Quick Access Toolbar functionality switches the menu bar visibility. 
To specify the MENUBAR visibility, do one of the following: 
• On the ribbon, click Customise Quick Access Toolbar > Show / Hide Menu Bar. 
• On the menu, click Customise Quick Access Toolbar > Show / Hide Menu Bar. 
• In the command window, enter MENUBAR

TIPTIP
66

VISUAL STYLES

You can represent 3D models with a specified appearance. For example, if 
the model is in the schematic design stage, you can show the model to a 
design team in a “sketch appearance” and present it to customers in a 
“realistic appearance.” The different appearances, called Visual Styles, 
depend on the settings that change the edge, colour, and shading display.

TIPTIP
77

IMPORT STEP FILES

You can use the IMPORTSTEP command to import 3D models from STEP files. 
You can incorporate STEP file models into drawings.

TIPTIP
88

DWGUNITS COMMAND

The DWGUNITS command converts drawings to other unit systems. For 
imperial and metric units, the DWGUNITS command lets you maintain 
precision and consistency in various projects. This command enhances the 
workflow efficiency and ensures that the drawing adheres to project require-
ments and industry standards.

TIPTIP
99

LASSO SELECTION

You can use lasso selection to enhance efficiency and save time. With lasso 
selection, you can move the pointer around an area to specify and select 
entities in an irregularly shaped contour. This method helps you select complex 
groups of entities that do not have standard rectangular boundaries. It simpli-
fies the workflow and improves productivity.

TIPTIP
1010

PRACTICAL INSIGHTS



EXCLUDE BODIES FROM ANALYSIS

Multiple bodies can be excluded from analysis – a significant time saver 
when working with large analysis where not all components are relevant to 
the simulation study.

TIPTIP
11

GENERAL SPRING CONNECTOR

You can specify a general spring connector between flat, nonflat, and 
concentric cylindrical surfaces. The general spring connector uses 
distributed coupling to establish an enhanced spring connector formulation 
that improves the performance and accuracy of the simulation study.

TIPTIP
22

AUTOMATICALLY SAVE FILE AFTER 
MESHING AND ANALYSIS COMPLETES

You can turn on the option to automatically save a model file after meshing 
and after the completion of analysis. This prevents data loss in case of 
unexpected system crashes or power outages.

TIPTIP
33

CONVERGENCE CHECK PLOT

The Convergence Check Plot detects regions of the model where the solver 
has encountered contact convergence issues.

TIPTIP
44

INCLUDE/EXCLUDE MESH AND RESULTS 
WHEN COPYING FEA STUDIES

SOLIDWORKS gives you flexibility in your workflow where you can choose 
whether to include or exclude mesh and results when copying your FEA 
studies.

TIPTIP
55

DRAFTSIGHTSIMULATIONPRACTICAL
INSIGHTS

PRACTICAL INSIGHTS



DIAGNOSTIC TOOLS FLYOUT MENU

Easily access all of your favourite Diagnostic Tools in one place from the new 
Diagnostic Tools Flyout Menu in the Command Manager.

TIPTIP
66

PENALTY STIFFNESS CONTROL FOR 
CONTACT INTERACTION

You can specify a scale factor for the penalty stiffness for contact that is 
used in linear static studies. SOLIDWORKS Simulation uses a default scale 
factor of 1.0, however, you may select a lower scale factor to obtain an 
approximate solution faster to assess design iterations and the overall 
behaviour of a model.

TIPTIP
77

LINKAGE ROD CONNECTOR

The Linkage Rod connector can be specified between cylindrical faces, 
circular edges, or vertices, to model the behaviour of connecting rods. The 
Linkage Rod connector is available in all simulation studies including linear, 
nonlinear, and dynamics studies.

TIPTIP
88

COPY TABULAR SIMULATION RESULTS 
TO CLIPBOARD

You can copy tabular simulation results displayed inside PropertyManager 
to the clipboard and paste the copied data from the clipboard into a Micro-
soft Excel or Word document. 

TIPTIP
99

AUTOMATIC DETECTION OF 
UNDERCONSTRAINED BODIES

The Automatically Detect Underconstrained Bodies is useful to identify 
bodies that are not sufficiently constrained during simulation and can exhib-
it translational or rotational rigid body modes, before the solver completes. 
When the solver detects rigid body modes, you have the option to continue 
with the solution, or stop the solution and review the rigid modes using the 
under-constrained Bodies tool.

TIPTIP
1010

PRACTICAL INSIGHTS
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STEP’S Reward
+6013-664 3635

talk2us@cadcam.com.my
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From Concept to Creation :
How SOLIDWORKS Transforms SMC Automation’s Engineering 

Company Background

Established in 1978, SMC Automation (Malaysia) Sdn. Bhd. has grown into a trusted provider of automation 
solutions, specialising in pneumatic components, chillers, and sensors. Over the years, the company has 
earned a strong reputation for reliability, innovation, and customer-focused service, supporting industries as 
diverse as food and beverage, electronics, and manufacturing.

As part of the global SMC Corporation headquartered in Japan, SMC Malaysia is backed by an international 
network spanning more than 80 countries and regions. This global presence allows the company to combine 
world-class technology and resources with local expertise, ensuring customers receive high-quality products 
and tailored solutions that drive industrial efficiency.

Engineering for a Growing Demand

As SMC’s customer base expanded, thus did the 
complexity of its projects. Each industry brought 
unique requirements, often demanding intricate 
designs and rapid turnaround. For the 
engineering team, this meant balancing precision 
with speed while maintaining the flexibility to 
adapt designs across diverse applications. To 
sustain its growth and maintain its reputation for 
reliability, SMC looked for a design platform that 
would not only accelerate development but also 
strengthen collaboration across teams and 
provide the flexibility needed to serve a dynamic 
industrial landscape.

INDUSTRY USE CASE



SOLIDWORKS:
The Catalyst for Smarter Design

Partnering with IME since 2014, SMC introduced 
SOLIDWORKS into its engineering department as 
the foundation for design work. With its powerful 
3D modelling capabilities, SOLIDWORKS enables 
engineers to create accurate representations of 
pneumatic systems and automation components, 
while managing complex assemblies with ease. The 
ability to visualise how multiple parts fit and 
function together allows the team to detect 
potential issues early and make adjustments quickly 
to meet customer requirements.

This shift streamlined workflows, reduced reliance 
on costly physical prototypes, and shortened the 
overall development cycle. Equally important, 
SOLIDWORKS enhanced communication across 
departments — empowering engineering, 
production, and sales teams to collaborate 
seamlessly through shared digital models and 
technical data.

Steamlined Design for Greater Accuracy

With SOLIDWORKS Premium, SMC can deliver solutions to customers faster than ever. Its integrated tubing 
routing and simulation features help save valuable design time and identify potential issues before 
production. By streamlining the entire process—from 3D modelling to performance testing—the team 
reduces rework and improves accuracy.

This efficiency not only enables SMC to respond quickly to customer demands but also reinforces its 
commitment to delivering reliable, high-quality solutions that meet the evolving needs of the industry.

.

“With IME’s strong local presence, support is
always within reach. That reliability has 
made them a trusted partner for us.”

Mr. Yong KS
Engineering Supervisor.
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Vita Detection :
Driving Efficiency and Reliability in Security Technology

Headquartered in Canada, Vita Detection has been a 
pioneer in 3D Perspective X-Ray security systems since 
2005. Renowned for innovation, quality, and reliability, 
Vita Detection has consistently set the standard in global 
security. The company introduced several industry firsts, 
from integrating precious metal detection with X-Ray 
systems to launching the world’s first 
machine-learning-powered electronic media detection 
solution for loss prevention. Its proprietary XR-AI™ and 
VITA Sentinel™ software, combined with remote 
monitoring and servicing capabilities, continue to set new 
benchmarks in threat detection.

Today, Vita Detection’s scanners serve airports, railways, and other critical environments worldwide, 
delivering sharper imaging, faster assessments, and smarter analytics.

Company Background

As Vita Detection expanded across Asia and other global markets, customer demand grew rapidly. At the 
same time, the increasing complexity of new products required faster workflows and more efficient design 
management.

With multiple projects running at the same time, engineers initially relied on PDF drawings to review 
assemblies. While workable at first, this approach became limiting as products grew more sophisticated. A 
single design issue could take up to a week to resolve, slowing progress and making it difficult to manage 
projects at scale. To keep pace with growth, the team needed a more effective way to visualise components 
in 3D, collaborate seamlessly, and refine designs with greater speed and accuracy.

Engineering for Growth and Scalability
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Vita Detection implemented SOLIDWORKS to move 
from static PDF drawings to an interactive 3D CAD 
platform. The shift enabled engineers to review and 
refine complex components more efficiently, 
keeping projects on track and accelerating delivery.

The platform’s intuitive, user-friendly interface 
made it easy for the team to adapt, even for those 
without extensive CAD backgrounds. This lowered 
barriers to adoption and ensured that everyone 
could contribute effectively from the start. At the 
same time, SOLIDWORKS enabled designs to be 
created with manufacturing in mind, allowing 
products to transition smoothly from concept to 
production without unnecessary rework.

By improving coordination across teams and 
streamlining workflows, SOLIDWORKS has already 
helped Vita Detection enhance product 
performance, shorten development cycles, and 
strengthen its ability to scale operations 
effectively—all within the first year of adoption.

Streamlining Design with SOLIDWORKS

IME is friendly and approachable, with more 
than one person available to help at the same 
time. Working with them feels like a casual 
conversation, making complex solutions easy 
to understand.

Mr. Yogeswaran
Mechanical Engineer

The switch to SOLIDWORKS has brought clear 
improvements. Product quality has increased by 
more than 40%, with potential to reach 75% 
through continued optimisation. Development 
cycles are shorter, enabling the team to introduce 
innovations more efficiently and respond quickly to 
customer needs.

One of the most notable gains has been in problem 
resolution: design issues that previously delayed 
progress for a week can now be addressed within a 
single day. This agility allows Vita Detection to 
manage multiple projects simultaneously without 
compromising quality. Customers benefit from 
smarter, more reliable scanners, while internal 
teams experience higher productivity and 
innovation. By achieving these results in such a 
short time, Vita Detection has established a solid 
foundation for sustained growth, demonstrating 
how the right tools and partnerships can accelerate 
transformation at scale.

Delivering Measurable Results

INDUSTRY USE CASE



Redefining Water Systems :
Howern Wasser’s 3D Design Transformation

Howern Wasser, founded in 2014, is a Malaysian engineering company specialising in pure water systems. 
Serving industries where precision and reliability are paramount—including pharmaceuticals, medical devices, 
semiconductors, solar, oil and gas, and petrochemicals—the company goes beyond designing high-quality 
water systems to support wastewater treatment and reclamation, helping clients reuse and recycle water 
efficiently. 

Operating from Selangor and Penang with a growing presence across Asia, Howern Wasser has earned a 
reputation as a trusted regional leader, combining sustainable design practices with innovative technologies 
to meet the evolving needs of its clients.

Company Background

As projects grew larger and more complex, traditional 2D 
drawings—while long serving the team well—offered a 
limited perspective for clients, particularly those without 
engineering backgrounds. Visualising how systems would 
fit into real spaces became increasingly important.

Efficiency was another critical factor. Without 3D design, 
projects often required up to 30% spare capacity in 
fabrication to accommodate adjustments, adding both 
time and cost. With multi-million-pound projects 
becoming the norm, and the demands for precision, 
optimised resources, and faster delivery on the rise, 
upgrading to 3D modelling emerged as a natural and 
necessary step.

Scaling Up with Complexity

INDUSTRY USE CASE
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To meet these evolving demands and continue 
delivering precise solutions, Howern Wasser 
adopted SOLIDWORKS 3D modelling. The shift 
enabled the creation of highly detailed, accurate 
models that clients could easily visualise and 
explore, providing a clearer understanding of 
system layouts than traditional 2D drawings.

By presenting systems in a three-dimensional 
format, the team could demonstrate how each 
component fit into the overall space, highlight key 
design features, and identify potential adjustments 
before fabrication. This approach allowed engineers 
to anticipate design clashes, optimise space usage, 
and make modifications earlier in the process, 
reducing rework. Discussions with clients became 
more interactive, alignment on expectations 
improved, and project planning and execution 
became more streamlined, ensuring projects 
progressed more smoothly from concept to 
installation.

Turning Drawings into 3D

IME is more than a solution provider; they are 
a supporting partner in our growth journey, 
helping us deliver greater value to our 
customers

Mr. Regis Bernard

Even in a brief period, the move to 3D design delivered measurable gains—reducing errors by 30–40% 
through precise modelling and accurate bills of materials, and cutting fabrication costs by around 20% by 
eliminating excess spare parts. Project timelines also improved by 20–25%, enabling systems to be 
fabricated and delivered more efficiently. Clients now benefit from clearer visualisations, enhancing 
communication and strengthening trust in the company’s capabilities. By embracing 3D modelling early, 
Howern Wasser is well-positioned to take on both SME and large-scale projects, where 3D design is rapidly 
becoming the industry standard. 

Smarter Design, Faster Results
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Building Strong Foundations with 
Innovative Design

From powering city streets to enabling modern communications, PMW Group of Companies has long shaped 
everyday infrastructure. Established as a trusted manufacturer of piles, poles and monopoles, the company 
serves both local and international markets with a diverse portfolio—from electric distribution poles and 
wiring supports to telecommunication monopoles and decorative lighting poles, including signature designs 
seen around mosques and public spaces.

Beyond finished products, PMW also specialises in the design and production of moulds and machinery for 
concrete product’s manufacturing—from concrete to metalworking—supplying overseas customers with tools 
that uphold quality and consistency. With its monopole division, the company extends its expertise further 
by delivering complete solutions with accessories that integrate seamlessly with modern telecommunications 
equipment.

Company Background

As PMW expanded to deliver larger and more advanced 
pole structures, particularly in the telecommunications 
sector, the company recognised the importance of a 
design approach that could handle complex assemblies 
with both speed and accuracy. With bigger projects came 
higher expectations—driving the need for tools that 
could streamline workflows and strengthen design 
precision.

At the same time, PMW placed strong emphasis on 
equipping its engineering team with the right resources 
and continuous support, ensuring they could work 
efficiently, innovate confidently, and meet rising 
customer demands.

Rising to Meet Bigger Demands
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The adoption of SOLIDWORKS 3D design software gave PMW the clarity and efficiency it needed to keep 
pace with growth. Known for its user-friendly interface and powerful assembly management features, the 
software enabled engineers to quickly identify the source of errors instead of relying on time-consuming 
trial-and-error corrections. This not only minimised rework but also helped the team maintain accuracy 
when dealing with large, complex structures like telecommunication monopoles.

Beyond error detection, SOLIDWORKS enhanced the entire design process. Engineers could visualise 
assemblies in greater detail, test how components fit together, and make adjustments in real time. This 
intuitive and streamlined approach reduced repetitive tasks, accelerated project timelines, and gave the team 
more freedom to focus on innovation and delivering high-value solutions to customers.

When Precision Meets Innovation

IME team is very responsive - always quick to 
address questions and patient in guidance. 
They’ve made a real difference in ensuring 
smooth adoption and long-term success. 

En. Mohd Faisal bin Ibrahim
Mechanical Engineer

The adoption of SOLIDWORKS transformed PMW’s engineering operations in measurable ways. Design 
cycles became 15–20% faster as errors were detected and resolved with far greater efficiency. With less time 
spent troubleshooting, engineers could focus on design and innovation, driving a significant boost in 
productivity. At the same time, enhanced accuracy strengthened confidence in every project, reducing rework 
and ensuring smoother delivery. These improvements not only elevated daily efficiency but also reinforced 
PMW’s reputation for reliability, positioning the company to drive innovation and strengthen its role in 
shaping tomorrow’s infrastructure.

Results That Speak for Themselves
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The Power of Integration: How HICOM Diecasting
Reduced Costs and Boosted Efficiency

For over three decades, HICOM Diecasting Sdn. 
Bhd. has been a trusted name in die-casting 
solutions. Incorporated in 1985 and wholly 
owned by HICOM Engineering Sdn. Bhd., a 
subsidiary of DRB-HICOM. HICOM Diecasting Sdn. 
Bhd. offers clients a cutting-edge combination of 
technology, technical know-how and a 
highly-skilled workforce, establishing itself as a 
leading die casting provider in the region. The 
company focuses on its core competencies to 
continuously evolve and shape its vision, driving 
the industry’s future.

Company Background Challenges
Building on Strong Fundamentals
The team is well-versed in the fundamental functions 
of their software, giving them a solid foundation in 
design. With this expertise in place, they are now 
eager to explore more advanced tools and integrated 
solutions unlocking greater innovation, independence 
in design preparation, and a faster workflow from 
concept to production.

Accuracy and Quality Concerns
Without stronger digital tools, ensuring design 
accuracy and consistent die-casting quality was a 
challenge. Small design errors could lead to 
production issues, higher rejection rates, and missed 
opportunities to optimise the process.

Dependence on External Suppliers
For certain advanced and critical design work, the 
company engaged external suppliers to support 
project delivery. While this approach provided access 
to specialised expertise, it also introduced time 
constraints that occasionally affected project 
timelines and efficiency.

Enhanced Turnaround & Stronger Credibility
With the adoption of an integrated CAD-CAM 
workflow, the company is positioned to respond to 
urgent or ad-hoc projects more quickly and efficiently. 
This improvement not only increases productivity but 
also strengthens agility in meeting client needs, 
further reinforcing their reputation for reliability.
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In Malaysia, there are many software suppliers to 
choose from, but with IME, I found everything I 
was looking for in a partner. Working with IME 
means having their full support, along with the 
knowledge and software expertise to back us up. 
My team and I are truly happy to work with IME.

Ts. Muhammad Faqrul Reduan Abdul Majid
Head of Tooling, Component & Equipment Development (TCED),

HICOM Diecasting Sdn. Bhd.

Solution with IME

An Integrated Workflow from Design
to Manufacturing

The company now operates on a complete digital 
toolset. SOLIDWORKS Premium enables advanced 
3D modelling and validation, while SOLIDWORKS 
Inspectionautomates quality checks and 
DraftSight supports 2D drawing needs. Together 
with CAMWorks and Mastercam, the team can 
seamlessly transition from CAD to CAM, allowing 
faster prototyping, improved accuracy, and 
stronger quality control. This integration 
eliminates bottlenecks and prevents costly defects 
early in the process.

With IME’s support, HICOM Diecasting adopted a 
fully integrated CAD-CAM solution that 
transformed the way the engineering team works 
from design to production. This new ecosystem 
reduced reliance on external suppliers, empowered 
in-house expertise, and delivered measurable 
business value.

Empowering the Engineering Team
The shift to in-house design and validation has 
significantly boosted team productivity. Engineers 
now tackle challenges with greater autonomy, 
reduce lead times, and contribute more directly to 
project outcomes. This empowerment has also 
lifted morale, giving the team confidence and 
pride in owning the design process rather than 
relying on external suppliers.

Driving Tangible Business Results
The transformation has delivered clear financial 
and strategic benefits. By reducing supplier 
dependency, HICOM Diecasting achieved an 
impressive 64% cost saving in the die-casting 
department.
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Driving Precision with Smart Monitoring at
LEP Precision Components Sdn Bhd

In high-precision manufacturing, even the smallest variation 
can make or break quality. For LEP Precision Components Sdn 
Bhd, a zinc die-casting and metal finishing specialist in Shah 
Alam, plating quality isn’t just important — it’s essential. 
Every part that leaves the factory must meet strict standards 
of reliability and consistency. For LEP’s customers, precision is 
demanded at every stage.

Company Background

LEP began as a zinc die-casting company and has grown into 
a trusted OEM partner, offering design-to-assembly solutions. 
Plating finishing remains its core strength, serving industries 
where repeatability and cost efficiency are critical. The 
company’s mission is to deliver the highest standards of 
quality while keeping processes lean and competitive.

From Die-Casting to OEM Partner

Among many tightly controlled processes, plating requires special attention to pH and temperature control. 
These two factors directly affect plating performance, product consistency, and costs. Traditional monitoring 
methods, including grab sampling, pH test papers, and manual thermometers, provide only periodic readings. 
Adjusting pH manually requires frequent checks, and even occasional delays can allow levels to drift outside 
the optimal range.

Temperature control presents similar challenges. Hourly readings are needed to track variations, yet hot and 
cool spots in the bath can produce inconsistent results, and sudden fluctuations may go unnoticed between 
checks.

The result is a process prone to undetected variations, inconsistent measurements, and costly rework. As 
production scales up, these manual methods struggle to keep pace with quality goals, highlighting the need 
for a more reliable, real-time solution.

The Hidden Costs of Manual Monitoring
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Teksoft provides professional services and 
has great problem-solving skills. We look 
forward to future grant projects with other 
solutions from Teksoft.

Mr. C. P. Tan
MDE Manager,

LEP Precision Components Sdn. Bhd.

How Digital Control Replaced Guesswork
Since 2009, LEP has partnered with the IME Group of Companies - beginning with design solutions that 
helped mature its product development processes. By 2024, the collaboration had expanded into 
manufacturing, where LEP sought to further strengthen process control and efficiency. This led to the 
adoption of SMAC (Smart Monitoring and Control), a system designed to remove the guesswork from critical 
operations. It continuously tracks pH and temperature in real time, sending instant alerts whenever values 
move outside the optimal range.

This automation eliminated the need for hourly manual checks and frequent pH adjustments, giving 
operators full visibility and control over the process — even remotely via smartphones or tablets. All data is 
recorded digitally, enhancing traceability for audits and supporting ongoing process improvement. By 
turning a labour-intensive, error-prone task into a reliable, data-driven operation, SMAC ensures consistent 
quality and efficiency for every batch.

The implementation of SMAC led to a 
significant transformation in LEP's plating 
process. Downtime dropped significantly, and 
plating consistency improved, resulting in a 
reduction of rejects and rework by around 
15–20%. Waste and operating costs also 
decreased noticeably.

Most importantly, SMAC eliminated the need 
for hourly manual temperature checks. 
Real-time digital monitoring now ensures 
quality control 24/7, audits run more smoothly, 
traceability is stronger, and operators can focus 
on production rather than routine monitoring.

Immediate Results: 
Higher Quality, Lower Costs

For LEP, SMAC wasn’t just a tool — it was a 
transformation. What made the difference was 
IME and Teksoft’s partnership approach, from 
smooth implementation to ongoing support.

Today, LEP’s plating process is smarter, more 
resilient, and ready for Industry 4.0. The 
journey proves that precision and innovation 
truly go hand in hand.

A Partnership Beyond Technology
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Driving Innovation in Plastic Sanitaryware
Manufacturing

Since its establishment in 1994, Prominent Image Sdn. Bhd. 
has grown into one of Malaysia’s leading manufacturers of 
plastic sanitaryware. Known for its Techplas brand, the 
company offers a wide range of durable bathroom 
fittings—including toilet seats, cistern tanks, bottle traps, and 
shower accessories—trusted for quality and reliability across 
the local building industry.

While Prominent Image’s core customer base remains in 
Malaysia, its reputation has expanded beyond borders, with 
products now exported to markets across Asia, the Middle 
East, and Africa. With a clear vision to become the top choice 
for Malaysians and a globally recognised sanitaryware 
brand, the company continues to scale operations while 
focusing on delivering excellence in both product and service.

Company Background

As the company expanded, it became clear that existing processes needed to evolve to keep pace with growth 
- particularly in production monitoring and inventory control. Manual temperature and pressure checks were 
carried out every two hours by the quality assurance team, a method that worked in earlier years but was no 
longer scalable. Gaps between checks could affect product consistency and lead to avoidable downtime.

Inventory management also relied heavily on manual logging. Stock counts and order request forms were 
written by hand, which sometimes resulted in inaccurate data or misplaced records. As order volumes grew, 
these inefficiencies highlighted the need for a more reliable, integrated system.

To sustain growth and maintain high standards, Prominent Image began seeking smarter, automated 
solutions that could enhance both production efficiency and supply chain accuracy.

Scaling Up with Smarter Systems
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To tackle these challenges, Prominent Image 
partnered with IME to implement a suite of smart 
manufacturing solutions — CIMCO, Parameter 
Monitoring, and MAPS — that would digitalise 
production and inventory processes across the 
factory floor.

With CIMCO software and real-time parameter 
monitoring, the company now has complete 
visibility into machine performance. The system 
automatically calculates Overall Equipment 
Effectiveness (OEE) by tracking availability, 
performance, and quality, giving users a clear picture 
of efficiency at a glance. Real-time monitoring of 
critical parameters such as temperature ensures 
accurate insights, while immediate alerts allow 
technicians to take fast corrective action to protect 
product quality and minimise downtime.

On the materials side, MAPS digitised inventory 
tracking. Previously dependent on handwritten 
records, the system now provides live updates on 
material usage and stock levels, with data 
centralised and easily accessible. This has led to 
greater accuracy, better planning, and significantly 
fewer inventory-related issues.

Turning Data into Decisions with IME

What makes IME stand out is their ability to 
customise solutions according to our require-
ments while keeping costs affordable.

Alex Low
General Manager,

Prominent Image Sdn. Bhd.

The digital shift has delivered clear benefits. Prominent Image has achieved approximately 8% cost savings 
per machine on monthly production, thanks to better machine oversight and reduced rejection rates. 
Inventory accuracy has improved around 95%, helping to minimise waste and optimise material and 
production planning.

These operational improvements have had a direct impact on customer satisfaction. With more consistent 
product quality and dependable delivery timelines, the company is better equipped to serve both local and 
international clients.

Internally, the transformation has fostered a culture of data-driven decision-making and continuous 
improvement. The company is now well-positioned to expand into new markets and scale production 
without sacrificing quality or efficiency.

“We believe there’s still plenty of opportunity to work together, especially as we look to equip our remaining 
machines with additional sensors,” says Alex Low. “This will reduce manual labour and provide even more 
precise data.”

As Prominent Image continues its digital transformation, this forward-looking approach ensures the 
company remains competitive and resilient in a rapidly evolving industry.

Tangible Results, Strategic Gains
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Accelerating Quality Inspections in Aerospace:
How Latécoère Digitised with 3DEXPERIENCE®

Founded in 1917, Latécoère is a Tier 1 partner to 
major aircraft manufacturers such as Airbus, Boeing, 
and Dassault Aviation. With over a century of 
aerospace experience, Latécoère is globally recognised 
for its expertise in aerostructures and interconnection 
systems. The company operates in 13 countries and is 
known for driving innovation, particularly in the 
design and manufacture of fuselage sections, doors, 
and electrical wiring systems for civil and military 
aircraft.

Latécoère is also committed to staying on the cutting 
edge of aerospace manufacturing, continually 
investing in smart factory technologies and digital 
transformation to meet the evolving demands of 
aircraft production and safety.

Company Background

As the aerospace sector evolves, so do the challenges that manufacturers like Latécoère must confront. One 
of the most pressing issues was found deep within the company’s inspection processes. Traditionally, quality 
checks relied heavily on manual procedures, paper-based documentation, and time-consuming visual 
inspections. While thorough, these methods were no longer sustainable at the scale and speed modern 
aerospace production demands.

Every component Latécoère manufactures must meet rigorous safety and compliance standards, with zero 
margin for error. Yet, with traditional workflows, inspections became a bottleneck—slowing production, 
increasing the potential for mistakes, and making it difficult to access real-time quality data. These 
inefficiencies not only affected productivity but also placed strain on skilled inspectors, whose time was often 
consumed by administrative tasks instead of value-added quality assurance.

When Quality Becomes a Bottleneck
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In search of a smarter, faster, and more connected 
approach to quality inspection, Latécoère turned to 
the 3DEXPERIENCE® platform from Dassault 
Systèmes. The company implemented DELMIA 
applications within the platform to transition from 
manual inspection procedures to a fully digital, 
model-based system.

This shift was not simply about introducing new 
software—it was about transforming the way 
quality was managed across the organisation. With 
3DEXPERIENCE, Latécoère integrated its 
inspection processes directly with design and 
manufacturing, creating a closed-loop 
environment where every step could be virtually 
planned, executed, and monitored.

Now, inspectors use 3D models to guide their 
checks, receiving precise digital instructions 
tailored to each part or assembly. These 
instructions are generated automatically from the 
original design, ensuring consistency across teams 
and locations. The system also captures inspection 
data in real time, enabling instant feedback and 
complete traceability from design to delivery.

A Digital Leap Forward

The impact of this digital transformation has been nothing short of remarkable. Latécoère has significantly 
reduced the time required for inspections, in some cases cutting it by as much as half. By eliminating paper 
documentation and automating key processes, the company has freed up inspectors to focus on higher-value 
tasks—boosting both accuracy and efficiency on the shop floor.

Training new personnel has also become easier. With intuitive, step-by-step digital guidance, new inspectors 
can get up to speed faster, reducing onboarding time and minimising errors. Perhaps most importantly, the 
shift has given Latécoère complete visibility into its quality operations. Every action is recorded, every 
outcome is traceable, and every issue can be addressed proactively—enhancing compliance and readiness for 
audits.

This transformation is more than a technological upgrade; it is a strategic move that positions Latécoère at 
the forefront of digital aerospace manufacturing. By partnering with Dassault Systèmes and leveraging the 
3DEXPERIENCE platform, the company has ensured that its commitment to quality not only meets today’s 
standards but is future-ready.

Results That Speak for Themselves

With DELMIA Augmented Experience we are 
reducing inspection time by 20% to 30% 
and it makes our inspection methods more 
reliable.

Grégory Marrocco
Industrial System Digitalisation Manager,

Latécoère
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Precision in Minutes: How VTube-LASER and FARO® 
Quantum Arm Are Transforming Tube Fabrication

Advanced Tubular Technologies, Inc., based in Michigan, 
specialises in software solutions for the tube fabrication 
industry. With a focus on precision, automation, and 
efficiency, the company has developed tools that streamline 
complex measurement and bending processes. Its flagship 
product, VTube-LASER, is now used by manufacturers across 
the aerospace, automotive, hydraulic, shipbuilding, and 
defence sectors.

The company’s customer base includes high-profile clients 
such as Delta Air Lines, British Airways, United Airlines, and 
multiple branches of the US military. Advanced Tubular’s 
software plays a central role in enabling these manufacturers 
to maintain strict dimensional tolerances and high 
productivity levels. The development of VTube-LASER reflects 
the company’s mission to modernise tube measurement 
standards and set new benchmarks for speed, accuracy, and 
integration.

Company Background

Prior to the adoption of laser scanning technologies, tube inspection and correction were traditionally 
handled using physical gauges, jigs, and fixtures. In this legacy process, operators bent a tube, placed it into 
a fixture to check for fit, and manually determined necessary corrections. Adjustments required trial and error, 
often consuming several hours per part.

This manual approach introduced variability, delayed production timelines, and increased material waste. It 
also placed a heavy reliance on operator experience and judgement, making repeatability a persistent 
challenge. As manufacturing demands grew more complex, and as precision and lead-time expectations 
tightened, these older processes became a limiting factor in operational efficiency.

Outdated Methods, Unacceptable Costs
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VTube-LASER, developed by Advanced Tubular 
Technologies, pairs with the FARO® Quantum Arm 
to replace manual tube inspection with fast, 
real-time laser scanning. It uses model-based 
definition (MBD) to import STEP files, analyse 
geometry, detect deviations, and send correction 
data directly to tube bending machines—reducing 
set-up time and improving first-part accuracy.

With built-in Benderlink™ technology, the system 
connects to a wide range of CNC benders, 
eliminating manual data entry and minimising 
errors. It also supports reverse calculation for 
reverse engineering. Designed for ease of use, 
VTube-LASER streamlines the workflow from scan 
to correction in just a few steps.

A Smarter Approach to Precision

The VTube-LASER and FARO® Quantum Arm system reduces tube inspection and correction time from hours 
to under 15 minutes, enabling faster changeovers, lower labour costs, and increased throughput. It offers 
superior accuracy and repeatability compared to legacy tools, reducing rework and improving part quality.

The system supports round, square, and rectangular tubing, as well as complex geometries and reverse 
engineering. Its 3D scanning capabilities also extend to non-tube components such as automotive panels. 
With immediate ROI, greater efficiency, and seamless machine integration, VTube-LASER delivers a 
high-speed, data-driven workflow that modernises tube fabrication and enhances competitiveness.

From Hours to Minutes: The Measurable Impact

I have a great working relationship with 
FARO; I value that relationship. It’s been a 
very positive experience and they’ve provided 
a lot of support and enthusiasm. They’re very 
knowledgeable people.

Michael Cone
Owner,

Advanced Tubular Technologies Inc.
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Smart Manufacturing:
Your First Steps Toward Transformation

The path to smart manufacturing rarely starts with sweeping 
changes. It begins with visibility. Many manufacturers still 
face blind spots: machines running idle, untracked downtime, 
or bottlenecks that only surface too late. With the right 
monitoring system, managers gain real-time insights into 
what’s happening on the shop floor — creating a foundation 
for better decisions and improved productivity.

Next comes precision. Manual checks often lead to 
inconsistencies and missed defects. Automated inspection 
ensures accuracy, repeatability, and confidence in quality — 
freeing skilled workers to focus on higher-value tasks.

Then comes efficiency. By connecting processes and 
streamlining workflows, automation reduces waste, 
eliminates unnecessary steps, and ensures every action adds 
value.

Finally, there’s productivity. Collaborative robots (cobots) take 
on repetitive, physically demanding jobs while working safely 
alongside people. The result? Faster output, safer workplaces, 
and a workforce that can channel energy into innovation 
rather than fatigue.

Manufacturing has long been the backbone of Malaysia’s economy, contributing nearly 25% of national GDP and 
employing millions of workers. Yet as global industries advance, local manufacturers face mounting pressures: rising 
labour costs, skills shortages, increasing demand for customised products, and the need to stay competitive on the world 
stage.

To meet these challenges, factories across Malaysia are entering a new era of Smart Manufacturing — where connected 
systems, robotics, and digital intelligence are deployed to boost productivity, strengthen resilience, and build more 
sustainable operations. Globally, industrial automation is expanding rapidly, driven by the demand for smarter, faster, 
and safer production. In Malaysia, this momentum is reinforced by the Industry4WRD policy, which aims to position the 
country as a high-value, technology-driven hub.

Surveys reveal that 80% of Malaysian manufacturers view automation as critical to competitiveness, with labour 
shortages being a major driver for solutions such as cobots and process monitoring. Yet cost and skills gaps remain the 
biggest barriers — highlighting the need for practical, phased approaches to adoption.

From Visibility to Productivity

SMART MANUFACTURING



For many, the idea of “smart automation” feels daunting 
— conjuring images of fully automated, lights-out 
factories with huge investments. But in reality, 
transformation happens one step at a time:

• Start with machine monitoring to uncover hidden
   inefficiencies.

• Adopt automated inspection to raise consistency and
   reduce errors.

• Integrate workflows to streamline production and
   connect processes.

• Deploy cobots to handle repetitive, labour-intensive
   tasks.

• Expand with predictive systems to forecast
   performance and prevent downtime.

Each step delivers value on its own, but together, they transform factories into smarter, more connected environments. 
Just as importantly, this phased approach reduces financial burden, minimises operational risk, and builds trust among 
operators and management alike.

At IME, we believe smart manufacturing should be practical, accessible, and sustainable for companies of every size. Our 
role goes beyond supplying technology — we act as a partner, guiding manufacturers through each stage of their 
transformation.

We enable companies to bring visibility into their operations through real-time monitoring, strengthen quality and 
consistency with automated inspection, and improve efficiency by streamlining workflows and integrating processes. 
We also help boost workforce productivity with automation that complements people rather than replaces them, while 
enabling leaders to unlock insights and foresight with analytics and predictive intelligence for smarter decision-making.

As a solutions provider with decades of experience 
supporting local industries, IME understands the unique 
challenges Malaysian manufacturers face. That’s why we 
also focus on building people capabilities — offering 
training, advisory, and skills development to ensure 
teams are equipped to adopt, adapt, and grow with these 
technologies. From design and simulation to additive 
manufacturing and digital transformation, we empower 
companies to build long-term capabilities that deliver 
lasting impact.

By aligning with national Industry4WRD aspirations, IME 
helps manufacturers not only adopt smart technologies 
but also future-proof their operations for global 
competitiveness. Because smart automation isn’t only for 
global giants with big budgets — it’s for every Malaysian 
manufacturer ready to take the first step.

Take the first step with IME — and see how your 
challenges can become opportunities for smarter, more 
competitive growth.

Building Smarter Factories, Step by Step

IME’s Role in Empowering Transformation
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From Concept to Reality:
How AM is Transforming Malaysian Manufacturing

This evolution isn’t just theoretical — Malaysian companies are already demonstrating AM’s value through practical 
applications.

In automotive, manufacturers can produce lightweight brackets and customised assembly jigs that cut production time 
by nearly 40%, reduce material waste by 30%, and shorten tooling lead times from weeks to days. The redesigned parts 
have passed rigorous fatigue and load testing, showing a 20% improvement in structural integrity — a crucial factor for 
safety-critical components. These gains translate into lower operational costs, faster product iteration, and reduced 
downtime on the line.

Healthcare is experiencing equally transformative 
outcomes. Hospitals are now creating patient-specific 
anatomical models, implants, and surgical guides in 
days rather than weeks. This allows surgeons to plan 
complex procedures with greater precision, reducing 
time in the operating room and improving patient 
outcomes.

Similar advances are also emerging across aerospace, 
consumer goods, high-tech electronics, and even 
architecture — where AM is enabling lighter, more 
efficient components, faster customisation, and clearer 
design communication.

Manufacturers today face mounting pressures: the need to innovate faster, reduce costs, and meet increasingly 
customised demands. Traditional production methods, while reliable, often struggle to deliver the speed and flexibility 
required in today’s global market. Additive Manufacturing (AM) changes that — enabling businesses to design, produce, 
and deliver parts directly from digital files, faster and smarter than ever before.

For years, 3D printing in Malaysia was mainly seen as a designer’s tool — ideal for mock-ups and visual models but rarely 
considered beyond prototyping. Today, that perception is shifting. AM has matured into a production-ready technology 
that is reshaping key sectors across Malaysia — from aerospace and automotive to healthcare, high-tech electronics, 
architecture, consumer products and beyond. Across these industries, AM is delivering speed, precision, and agility that 
conventional methods can’t always match

Equally important, AM brings strong sustainability benefits. By reducing material waste, enabling on-demand 
production, and localising supply chains, it supports more resource-efficient manufacturing while lowering the 
environmental footprint. This combination of innovation, efficiency, and sustainability makes AM one of the most 
compelling technologies driving the future of manufacturing.

Real Results from Functional Pilots
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These examples show how AM has moved beyond its R&D roots to become a critical enabler of next-generation 
manufacturing and healthcare solutions.

Building on these early successes, Malaysian companies are now moving beyond prototypes to produce certified, 
end-use parts directly from digital files.

In aerospace, lightweight jigs and fixtures are cutting lead times while meeting strict safety standards. Manufacturing 
floors are boosting productivity and quality with custom jigs, inspection fixtures, and ergonomic aids. Architecture firms 
are creating highly detailed, scale-accurate models that communicate design intent clearly to clients and stakeholders.

By eliminating costly tooling and molds, AM proves especially valuable for low-volume production. Companies can 
produce on demand, reduce waste, and respond faster to customer needs — all while maintaining flexibility and 
precision.

From Concept to Production

Leading the Future: How IME Helps Companies Master AM
The next step for Malaysian manufacturers is not only to 
adopt AM, but to unlock its full potential across design, 
production, and business models.

IME supports this journey by providing:

The future of manufacturing in Malaysia is already here 
— faster, smarter, and more sustainable. IME is ready to 
help companies lead this transformation, turning today’s 
opportunities into tomorrow’s competitive advantage. 

• End-to-End Consultation – from identifying the right  
applications to designing business cases that prove ROI.

• Technology Deployment – delivering world-class AM 
systems tailored to production requirements.

• Material and Process Expertise – helping companies 
select the best materials and optimise workflows for 
consistency and quality.

• Ongoing Support and Collaboration – ensuring success 
through operator guidance, technical support, and 
continuous innovation partnerships.

Additive Manufacturing is no longer just a tool — 
it’s a game-changer for how products are 
designed and made. At IME, we enable companies 
unlock its full potential and turn innovative ideas 
into real, production-ready solutions.

JY Teoh
Executive Vice President

IME Group of Companies
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Precision Care: How 3D Printing is Transforming
Healthcare in Malaysia
From medical devices to training simulations — IME is bridging technology and healthcare
for a safer, smarter future.

Globally, the medical 3D printing market is one of the fastest-growing in healthcare technology. Industry studies 
estimate the sector at USD 3.5 billion in 2024, with projections to surpass USD 12 billion by 2032, growing at a CAGR 
of nearly 17%.

Locally, surveys with about 100 doctors and medical professionals revealed a similar trend: while 91% had not yet used 
3D printing, 80% expressed strong interest in adopting it for pre-surgical planning, surgical guides, and training.

Proven Growth & Global Momentum

Medicine is constantly evolving, with new technologies reshaping how doctors diagnose, treat, and save lives. Among 
these innovations, 3D printing is proving to be one of the most powerful. No longer limited to engineering labs, it is now 
transforming operating rooms, classrooms, and research centres Malaysia.

At the heart of this shift is IME, working with hospitals, universities, and associations to unlock the potential of 3D 
printing in medicine. From virtual surgical planning to training simulators, IME is enabling doctors, students, and 
researchers improve precision, enhance learning, and accelerate innovation.

Where 3D Printing Makes a Difference

Medical education is moving beyond textbooks and 
cadavers — 3D-printed models allow students and 
professionals to practise procedures on lifelike, 
patient-specific anatomy.

1. Training & Simulation

AFC Ankle-Injection Simulator – IME partnered 
with the Asia Faculty of Clinical Ultrasound (AFC) 
to create a realistic ankle-injection simulator, 
giving trainees hands-on practice before treating 
real patients (Refer Image 1)

•

Image 1: AFC Ankle-Injection Simulator
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Universiti Malaya (UM) Anatomy Teaching – UM 
integrated 3D printing into its anatomy curriculum, 
enabling students, doctors, and medical officers to 
explore accurate, patient-specific anatomical models as 
part of their coursework (Refer Image 2)

•

Implant & Device Replicas – IME also produces 
3D-printed replicas of surgical implants for training, 
allowing hospitals to conduct hands-on workshops 
without using costly real implants, preserving them for 
patient care

•

Image 2: Universiti Malaya (UM) Anatomy Teaching

Perhaps most transformative is pre-surgical planning. Surgeons can now rehearse procedures on patient-specific models 
and use customised guides for greater accuracy. Collaborations with the Malaysian Society for Hip & Knee Surgeons 
(MSHKS), SIRIM, and UM have already produced orthopaedic training models and surgical guides such as those used in 
high tibial osteotomy (HTO).

2. Pre-Surgical Planning & Patient-Specific Guides

MSHKS: femur & pelvis models for orthopaedic training SIRIM & UM: high tibial osteotomy surgical guides & models

IME’s vision is simple: equip doctors, researchers, and 
students with the tools they need to advance care.

• For researchers → rapid prototyping and testing of 
   new medical ideas

• For professionals → simulators and virtual planning 
   tools to rehearse complex procedures safely

• For students & patients → 3D-printed anatomy models 
   that replace cadavers & improve patient understanding

To support this, IME offers a full suite of solutions: virtual 
planning, 3D printing services, product re-engineering, 
training simulators, and patient-specific instruments 
(PSI). Together, these turn innovation into real-world 
impact.

Bridging Medical Needs with Technology

Technology alone isn’t enough. By working with 
hospitals, universities, associations like MSHKS, SIRIM, 
AFC, and patients, IME is building a medical 3D printing 
ecosystem that strengthens the entire healthcare system.

As Malaysia pushes forward in advanced healthcare, IME’s 
role is clear: to make 3D printing accessible, affordable, 
and impactful.

Building Malaysia’s Medical
Additive Manufacturing Ecosystem

• Collaborative Projects – co-developing training models, 
   simulators, and surgical guides with hospitals and 
   associations

• Technology Deployment – providing world-class 3D 
   printing systems tailored to healthcare applications

• Specialised Services – from patient-specific 
   instruments (PSI) to re-engineered medical devices

• Knowledge Transfer – training and upskilling doctors, 
   researchers, and medical technologists in AM

With strong collaborations and a growing network, IME is 
helping shape a future where every doctor, student, and 
patient benefits from the precision and potential of 3D 
printing. For hospitals and institutions looking to explore 
the next step, IME is ready to turn innovation into 
everyday medical practice.

How IME Supports the Medical Community:

3D printing in medicine is more than technology. 
It is about enabling safer surgeries, smarter 
training, and more confident patients.

Sufian Hashim
Technologist, Additive Manufacturing in Life Sciences,

IME Group of Companies
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High Accuracy Real-time Indoor Tracking (ITS)
An indoor location track and trace system capable of performing high-accuracy position determination, storing and analysing 
the position of a tracked subject. This system is suited for Smart Manufacturing and Internet of Things (IoT) System use cases 
which require high-accuracy position awareness.

An Indoor Tracking System (ITS) is a high-accuracy track and 
trace system utilising Ultra-Wideband (UWB) technology. It 
supports real-time location data collection and analysis 
for IoT applications in 4IR (specifically Industry 4.0) 
environments. The system consists of four device types, 
namely tracked tags, fixed position anchors, gateway(s) to 
communicate with tags and anchors and a central server to 
receive, store and analyse tracked tag positions. Distance is 
measured directly through time-of-flight resulting in 
higher accuracy position determination.

Overview
ITS provides the following features:
Features

• Indoor Location Positioning
Accurately display a position in real time with visualisation 
on a real-time dashboard.

• Human or Asset Tracking Mode
Operation mode for either personnel/human or asset 
tracking with applications for workplace optimisation.

• User Geofence or Zone Creation
System’s user ability to create geofence areas of interest. 
Ability to assign work jobs/activities in zones if in human 
tracking mode, or assign specific areas of expected statically 
positioned assets in the tracked coverage area.

• Analytics and Report Generation
Analytics determining dwell time of tags in created zones
and density heatmap. In human tracking, overall daily 
dwell zone summary and dwells per job zone time / activity. 
In asset tracking, a report indicates tags in or out of assigned 
zones.

• Position Replay
Allow replay of tag movement for historical tracking 
review.

• API Access
Access to location data allows third parties to develop different 
analyses, applications and monitoring dashboards.

Manufacturing, Retail, Healthcare and Tourism.
Applications

The main impacts of ITS are:
Technology Benefits

• Digital Twin Representation for IoT / 
   Smart Manufacturing
Enable simulation of cyber-physical systems with real-time 
location data to enrich analysis and decision-making.

• IR4.0 Catalyst
Indoor positioning is a fundamental technology that 
enables innovative and practical use cases applicable to the 
industry.

Basic deployment of ITS

• Monitoring
• Analytics
• Visualisation

Manager

ITS anchors

Gateway

ITS
tagsAssets / Personnel

Wireless

Sample of tracking dashboard
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Cobot Palletizing Automation
Our cobot technology makes palletizing faster, more efficient, and more affordable than ever before. The cobot palletizers 
are advanced robotic systems that use cutting-edge technology to handle your palletizing needs. It can be 
programmed to handle a variety of products and packaging types, and their flexible design allows for easy adaptation 
to changing production needs.

Cost-effectiveness
Businesses can reduce labor costs while 
providing excellent ROI and long-term cost 
savings.

Increased Efficiency
Work faster and more consistently, 
enhancing operational efficiency and 
throughput.

Enhanced Workplace Safety
Designed with advanced sensors and safety 
features to keep employees and products 
safe.

Improved Accuracy
Ensure accurate product placement and 
stacking, reducing the risk of errors and 
product damage.

Why choose our Cobot Palletizing system?

Affordable price
Free on-site assessment
Fast & easy setup
Space saving design
Pick & place up to 20kg payload
Able to handle 2 pallets at once
Suitable for: 
     Food & beverage industry
     Cosmetic industry
     Consumer goods

•
•
•
•
•
•
•
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Machine Tending
It involves automating the process of loading and unloading materials in a machine. By minimising manual intervention, it 
increases efficiency, productivity, and allows for continuous production, freeing up human operators for more complex 
tasks in manufacturing operations.

Improved safety and reduced risk of 
workplace accidents.

Enhanced flexibility and adaptability to 
changing production needs.

Cost savings through reduced labor costs 
and increased efficiency.

Better utilisation of resources and 
optimisation of production processes.

Common machines for
Machine Tending:
• CNC Machines 
• Press and Forming Machines
• Welding Machines
• Injection Machines
• Metal Stamping Machines & many more

Why use Cobot for Machine Tending activites

Increased capacity, quality and minimised waste
Constant throughput
24/7 operation, increased uptime
Upgrading worker roles from repetitive loading 
and unloading to supervising and programming 
cobots
Easy to relocate and quickly redeploy with 
several machines in Low-Volume / High-Mix 
production environments

•
•
•
•

•

One Cobot handling two machines
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Smart Monitoring and Control (SMAC)
Smart Monitoring And Control (SMAC) is a control system architecture that consists of hardware and software elements 
for monitoring and controlling industrial processes and infrastructure by physical or remotely. SMAC system will integrate 
from sensor, controller which located in industrial environment and display actual information in real time, it also allows 
for certain control point action if necessary.

Energy Monitoring System in the Food & Beverage Industry
• Automated Temperature and Humidity Data Reporting
• Automated Energy Monitoring
• Parameter Monitoring (Pressure, Temperature, Humidity, Gas Consumption)
• Electricity Consumption and Savings
• Enabling manager to optimise Operational Cost while gradually monitoring
 production and making better decisions

Pump Monitoring System in the Manufacturing, Oil and Gas,
Water Treatment, and Agriculture Industry
• Environmental Monitoring (Pressure,
   Temperature, Humidity, Carbon Dioxide, Noise)
• Pump Overheat
• Pump Failure
• Overflow

• Liquid Level Setting
• Alarm Notification 
• Live Data for Every Pump
  (Run Time & Power)

Furnace Monitoring System in the Manufacturing, Cement,
Steel, Glass, and Power Plants Industry
• Indoor & Outdoor Environmental
  Monitoring (Pressure, Temperature)
• Temperature & Pressure Monitoring 
• Furnace Filling Level
• Actual Refill Weight

• Refill Time
• Number of Doses per Furnace
• Device Status
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Scheduler feature offers painless event 
management by allowing users to schedule 
events to occur at a specified time. Events 
can be scheduled on daily, monthly, or 
yearly basis.

Scheduler

SMAC provides interactive visualisation 
display to users such as charts, graphs and 
dashboards which ease users to understand 
the situation and the data display.

This will ease PIC to identify the risk and 
make decision as soon as possible.

Graphic Visualisation

SMAC system collects data from controllers 
& sensors in real-time from the production 
site and allows PIC to monitor critical 
parameters that will cause operation failure 
such as temperature reading, pressure level, 
flow rate, equipment status and etc.

Real-Time Monitoring

2D charts can be created based on logged 
data values.

Chart

KEY FEATURES - USER FRIENDLY INTERFACES

To control production process of 
different products, Recipe Editor offers 
easy configuration to create, save and 
edit the parameter sets. 

Recipe Editor

Advanced graphic image and animation 
library. Users can create their own 
animation by importing different 
graphic images. 

Simple graphic editing (including 
animation) can be done.

Library (Animation)

Configure to trigger alarms event and 
notification through email, or Telegram 
to PIC for next action response.

Alarms and Notification

Users can access webclient by web 
browser or mobile view to monitor 
and adjust settings.

Webclient for Remove View
and Control

OPC-UA, OPC XML-DA, Modbus RTU / 
TCP, BACnet IP, MQTT, SQL are integrated 
into the platform.

Multiple Protocols and
PLC Drivers

System can store historical data in database 
system and allow users to regenerate historical 
data report from the system as excel report.

Users can create reports in Excel (Microsoft 
Office Program) file formats on daily, monthly, 
or yearly basis.

Historical Data and Reporting

APPLY TO INDUSTRIES
Energy & Utilities      |      Water & Waste Water Management      |      Oil & Gas      |      Manufacturing

Building Automation      |      Agriculture      |      Food & Beverage Production
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Unlock the full potential of your production. 
Improve processes, resource use and
critical reponse times. 

MDC-Max enables you to collect and analyse data from 
machines and operators to get real-time and historic insights 
into your shop floor’s productivity, performance and quality. 
Data can be used for different purposes such as real-time 
monitoring with Andon boards throughout the company, for 
planning and analysis, or for export to ERP, MES or other 
systems.

What is CIMCO MDC-Max?Introduction

Actual Run Time
Potential Run Time

=

Availability

Actual Speed
Theoretical Speed

=

Performance

Good Output
Total Output

=

Quality

90% 90% 95%

OVERALL
EQUIPMENT
EFFECTIVENESS

= 77%

Office

Shop Floor

Monitor one or more locations
deeper analysis with reports

Out

Complete monitoring of machine
and operator status

Real-time status of
machines on big screen TV

Integration MED ERP / MES / Excel

Real-time status of machines based on
their location on Shop Floor

Access MDC-Max from anywhere
using mobile or tablet

Real-time Machine Data Collection
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CIMCO Edit

Full-featured NC editing, 
simulation and machine 
communication tool. Powerful 
add-ons available.

CIMCO DNC-Max

The leading solution for NC 
program transfers to and from 
CNC machines. Compatible with 
machines and files.

CIMCO MDC-Max

Real-time manufacturing data 
collection. Optimise use of 
resources, and streamline 
processes.

CIMCO NC-Base

Organise, manage, and protect 
part programs and related 
production documents 
efficiently.

CIMCO MDM

Complete solution for 
manufacturing document 
management. Integrates with 
CAD/CAM systems from 
leading vendors.

CIMCO Scheduler

Production schedulling and 
order tracking solution. Improve 
delivery times and use of 
machines and resources.

CIMCO Machine
Simulation

Prove-out your NC program on 
a 3D CNC machine model. 
Automatic checks for collisions, 
out of limit moves and more.

CIMCO CNC-Calc

A basic CAD/CAM. Draw 2D 
geometrical contours and lay 
out toolpaths for milling and 
turning machines.

CIMCO Mazatrol
Viewer

Enables CIMCO Edit to read, 
preview and print Mazatrol 
binary files for both milling and 
turning.

CIMCO Teachware

E-learning solution that 
introduces students to working 
with digital machine tools.

The full suite of CIMCO software

Real-time monitoring / Andon
See the current status and performance data of your 
machines on Andon boards, PC and mobile. Customise 
the layout and content of screens to suit your needs.

Customisable reports
Generate reports with calculation of OEE, downtime 
and other essential KPIs. Set production targets, work 
shifts and sort data by different factors.

Real-time reporting
Generate real-time reports that dynamically update 
as data comes in, such as machine timelines.

Works with your equipment
Collect data automatically or manually using
your existing wireless network, Ethernet, RS-232 or 
Parallel I/O. Use existing barcode readers and PCs on 
the shopfloor.

Integration with external systems
Streamline data management and workflows by 
updating ERP, MES or other administrative systems 
directly with data from MDC-Max.

Operator interface
Enables operators to access essential information 
directly at the machine and enter data such as current 
shift, job, reasons for downtime and scrap.

Andon and signaling units
Control signaling units such as stack lights, buzzers 
and Andon boards that indicate the status of your 
machines.

Email and text notifications
MDC-Max can send text and email alerts to key staff 
on any machine and operator event such as automati-
cally during unattended runs.

Secure user management
Fine-grained control over user access and permis-
sions. View logs of user actions and system events for 
auditing and troubleshooting purposes.

Key Features

Improved efficiency
Understand the performance of equipment and 
personnel with real-time data collection. Eliminate 
production bottlenecks and optimise resource 
utilisation.

Accurate data collection
Eliminate manual, time consuming and often 
inaccurate data collection by automating and 
streamlining the entire data collection process.

Faster response times
Monitor and visualise the performance of equipment 
and personnel to respond faster, catch errors sooner, 
and communicate better.

Eliminate guesswork
Understand the inner workings of your production 
with customised reports including machine 
downtime, OEE and other essential KPIs.

Reduce administration time
Reduce paper reliance and administrative time. 
Update your ERP, MES or other administrative 
system with real-time data from equipment and 
personnel.

Access your data anywhere
Access data from one or more sites directly from your 
mobile device. Easily check the status of equipment 
or any other information critical to your operation.

Why use CIMCO MDC-Max?Benefits
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PROGRAMME TITLE COURSE INTRODUCTIONDURATION
SOLIDWORKS

Everything you need to know about SOLIDWORKS for building parametric models of parts and 
assemblies, and making drawings of those parts and assemblies.5 DaysEssentials

A collection of several advanced CAD modeling techniques. It includes selected lessons and 
exercises from SOLIDWORKS Assembly Modeling, Advanced Part Modeling, Surface Modeling, 
Sheet Metal and Weldments. 

5 DaysAdvanced Topics

The Advanced Part Modelling course is for SOLIDWORKS users who need to create complex parts 
or just want to become more productive.3 DaysAdvanced Part Modelling

The Assembly Modelling course is a must for anyone who wants to master the use of 
SOLIDWORKS for creating and using assemblies.3 DaysAdvanced Assembly

Modelling

SOLIDWORKS Sheet Metal course is designed for users who need to learn how to model sheet 
metal parts that will be bent in a press brake.3 DaysSheet Metal Design

SOLIDWORKS Weldments can save up to 90% of your time. This is for any user who designs 
structures made out of components with constant profiles.2 DaysWeldments

(Structural Design)

This course will focus on the routing techniques for piping and tubing.2 DaysRouting - Piping
and Tubing 

This course will focus on the routing techniques for electrical.2 DaysRouting - Electrical

Mold Design course teaches you how to quickly generate the tooling for any given part and separate 
it into core and cavity components.3 DaysMold Design 

This course will introduce the participants to fundamental design validation tool for conducting static 
analysis.3 DaysSimulation

This course will introduce the participants to the design validation tool for conducting advanced 
analysis.2 DaysSimulation Professional

This course will introduce the participants to the nonlinear static structural
behaviour of part and assembly models.2 DaysSimulation Premium:

Nonlinear 

This course will introduce the participants to the linear & nonlinear dynamic
structural behaviour of parts and assemblies.2 DaysSimulation Premium:

Dynamics

This course will introduce the participants to the motion simulation for mechanism study.2 DaysSimulation Motion 

This course will introduce the participants to computational fluid dynamic (CFD) analysis for fluid flow 
and heat transfer studies.2 DaysFlow Simulation

This SOLIDWORKS Plastics course teaches you how to use specialised simulation software tools to 
predict how melted plastic flows during the injection molding process.1 DayPlastics Standard

This SOLIDWORKS Plastics course teaches you how to use specialised simulation software tools to 
predict how melted plastic flows during the injection molding process. This course covers all the 
features and functions of SOLIDWORKS Plastics Professional (for part designers).

2 DaysPlastics Professional

The SOLIDWORKS Plastics course teaches you how to use specialised simulation software tools to 
predict how melted plastic flows during the injection molding process. This course covers all the 
features and functions of both SOLIDWORKS Plastics Professional and Premium (for part and mold 
designers).

3 DaysPlastics Premium

This course will introduce the participants to 2D schematic design, including single line and multi-line 
diagram. Participants will also learn how to generate drawing output.3 DaysSOLIDWORKS Electrical:

Schematic 

This course will introduce the participants to electrical 3D features which include technique on 
integrating 2D schematic to SOLIDWORKS 3D and complete the drawing output.1 DaySOLIDWORKS Electrical:

3D

File Management course will discuss about different techniques for managing
CAD documents such as assembly, part and drawing documents.1 DaySOLIDWORKS File

Management

SOLIDWORKS Composer course will discuss the fundamental skills and concepts
central to complete publishing task.3 DaysSOLIDWORKS Composer

Fundamental skills and concepts central to the successful use of SOLIDWORKS PDM. The intended 
audience for this course is anyone who will setup and/or administer SOLIDWORKS PDM.2 DaysAdministering

SOLIDWORKS PDM

2026 IME TRAINING COURSES
TALENT DEVELOPMENT



PROGRAMME TITLE COURSE INTRODUCTIONDURATION
SOLIDWORKS

Fundamental skills and concepts central to the successful use of SOLIDWORKS PDM. The intended 
audience for this course is anyone who will use and manage files with SOLIDWORKS PDM.1 DayUsing SOLIDWORKS PDM

How to use the SOLIDWORKS API (Application Programming Interface) to automate and customise 
SOLIDWORKS.3 DaysAPI Fundamentals

This course teaches how to use the SOLIDWORKS Visualize software to create professional, high 
quality renderings, videos and VR outputs for marketing purposes. Focusing on Standard users.1 DayVisualize Standard

This course teaches how to use the SOLIDWORKS Visualize software to create professional, high 
quality renderings, videos and VR outputs for marketing purposes. Focusing on Professional users.2 DaysVisualize Professional

Learn the basics of working with SOLIDWORKS Inspection to automate the process of working with 
inspection documents.1 DayInspection

Use SOLIDWORKS CAM Standard to generate, modify and post-process 2.5 axis milling toolpaths 
used for machining of SOLIDWORKS part files.2 DaysCAM Standard

Use SOLIDWORKS CAM Professional and VoluMill™ to perform 3 plus 2 machining and generate, 
modify and post-process 2 axis turning toolpaths used for the machining of SOLIDWORKS part files.2 DaysCAM Professional

This course will discuss the formats and requirements of the CSWP Exam, including case studies on 
how to solve the questions in the exam.1 DayCSWP Refresher

SOLIDWORKS Certifications can be used as a benchmark to measure your knowledge and competency 
with SOLIDWORKS software.1/2 DayCSWA/CSWP Exam

Discover the forefront design and innovation on the new feature updates in the latest release of 
SOLIDWORKS.1/2 DayUpgrade (What's New

SOLIDWORKS 2025)

PROGRAMME TITLE COURSE INTRODUCTIONDURATION
3DEXPERIENCE

Enable you to effectively perform the activities associated with the roles of the 3DEXPERIENCE 
platform: Collaborative Business Innovator, Collaborative Industry Innovator and Collaborative 
Designer for SOLIDWORKS.

1 Day3DEXPERIENCE Essentials

The goal of this course is to teach users how to use the roles and applications included in the 
3DEXPERIENCE SOLIDWORKS Premium package.3 Days3DEXPERIENCE

SOLIDWORKS Premium

Create both mechanical and complex-shaped products, frame structures, and sheet metal designs on 
cloud. Collaborate in real-time across disciplines, departments, and your entire business ecosystem, 
including customers, partners, and suppliers.

3 DaysSOLIDWORKS Cloud

PROGRAMME TITLE COURSE INTRODUCTIONDURATION
DRAFTSIGHT

Use DraftSight 2D Drafting features to optimise your drawings and designs for manufacturability so 
you can maximise quality, avoid rework and decrease time to market.2 DaysDraftSight - 2D Drafting

Use DraftSight 2D and 3D Drafting features to optimise your drawings and designs for 
manufacturability so you can maximise quality, avoid rework and decrease time to market.3 DaysDraftSight - 3D Drafting

PROGRAMME TITLE COURSE INTRODUCTIONDURATION
INDUSTRIAL COURSES

Learn the calculation method that allows designers to control the overall tolerances from individual 
parts to the whole assembly.3 DaysStack-Up Analysis

This course will take the engineers through the three types of nonlinearities, and mesh refinement, 
with the objective of achieving accurate prediction of simulation FEA results. 5 DaysSimulation-Driven Design

This course looks at the various root causes of failed plastic parts so that participants can learn how to 
detect and deal with them.2 DaysDo It Right The First Time

(DRIFT) Plastics Design

This course examines the possible root cause(s) of the variety of problems encountered during the 
production, assembly and usage of injection molded plastic parts.2 DaysRoot-Cause Your Plastic

Part Problems
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COMMITTED TO PROVIDING THE HIGHEST LEVEL  OF CUSTOMER SERVICE

We RESPECT you as our valued customers   |   We LISTEN to your voice   |   We CARE about your needs

Contact us for more information: feedback@cadcam.com.my

We care for your needs and we want you 
genuine feedback for us to improve our 
services.

COMMUNICATION

We provide you with value added rewards & 
privileges as you are very important to us.

REWARDS

We believe in long term partnership and 
synergy to achieve more successes with you.

COLLABORATION

Continuous Learning is important to drive 
productivity & innovation. We recommend 
adequate skill training for your team to excel.

SKILL ENHANCEMENT

We aspire to deliver quality products & services 
to meet your satisfaction.

CUSTOMER SATISFACTION



Technical Support:
Email: swsupport@cadcam.com.my     |     Hotline: 1300-88-2797     |     WhatsApp: +6019-269 2054

www.cadcam.com.my     |      www.imetech.com.my

SELANGOR
22 Jalan PJS1/46, 
Taman Petaling Utama, 
46000 Petaling Jaya,
Selangor, Malaysia.

T: +603-7783 6866  

PENANG
68, Jalan Perai Jaya 4, 
Bandar Perai Jaya, 
13700 Pulau Pinang, 
Malaysia.

T : +604-399 5571

JOHOR
25-01, Jalan Bestari 8/2, 
Taman Nusa Bestari, 
79150 Iskandar Puteri, 
Johor, Malaysia.

 
T : +607-238 7978

SARAWAK
Private Off. Suite No. 1,
TEGAS Digital Village, Lot 3500,
Sama Jaya High Tech Park,
Blk. 12, Muara Tebas Land District,
93350 Kuching, Sarawak.

T: +6082-288 330

Follow us!

IME Technology Sdn Bhd is a member of Group of Companies, the leading and most established 
CAD, CAM and CAE solutions provider in Malaysia since 1980. IME offers extensive range of 
design to engineering solutions fixated around digital transformation namely Additive 
Manufacturing, Robots, Simulation, IoT, Big Data Analytics and System Integration in the 
manufacturing space.

IMPLEMENTATION ACROSS 

DESIGN & MANUFACTURING


